
WES-2 Bridge Test Case Job Sheets 
  

Task 1: Upload a small archived data case for event review (no simulation) and familiarize with 
simulation controls. 
 

1. Right click on the desktop and select Open in Terminal to launch a shell window. Issue the following commands 
to list out the contents of an archived data case before the metadata is added: 

a. cd /data1/wes_cases (note you can hit the tab key after starting to type out the paths and it will sometimes 
finish the command for you) 

b. ls w2b_exercise_case_14_3_1 
i. If a localization directory and/or a caseMetaData.xml file appear then this task has already been 

performed. If either of these is present, see Step 25 before continuing.  
c. ls w2b_exercise_case_14_3_1/Processed 

i. Note only some radar, satellite, warning, obs, grid, and ffmp data. 
 

2. To start WES-2 Bridge, either navigate to Applications à  WDTD à  WES-2 Bridge in the the top-left Desktop 
menu, or open a new shell window, cd /w2b/wes and type ./wes.sh and hit Enter. 
 

 
 

3. Once the WES II Bridge GUI loads, check to see if EDEX_00 is Active under the “EDEX Instances” list. If it is 
listed as Not Active, right click on EDEX_00 and select Start EDEX.  

 
 

4. Under the File menu select AWIPS Archive Case,  
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and in the wizard first page: 
a. Click on Browse button and navigate to /data1/wes_cases/ where you will select 

w2b_exercise_case_14_3_1. 
 

 
 

b. Check the “Use original archived data and do not copy to an alternate location” checkbox to leave 
the w2b_exercise_case_14_3_1 in its current location. 
 

Note: If you are using this GUI for your own local case AND are using /data/archiver for the 
source directory then you must uncheck this checkbox because WES-2 Bridge is unable to write 
to the /data/archiver directory.  

 
5. Click the Next button. 

 
6. In the wizard second page enter the following: 

a. Case Name: Exercise Case  
b. AWIPS II Version: 14.3.1 (this is used for tracking build dependencies) 
c. Case Description: archiver filtered case with radar, satellite, obs, warnings and FFMP data (this is 

useful documentation for later use) 
 

 
 

7. Click Next button. 
 



8. Under WFOs box, click on Deselect All button, and then select OUN. 
Note: if you had a lot of data you may choose to filter the data loaded in WES by using the Data Types 
box. 
 

9. Click the Next button. 
 

10. On the wizard third page enter the following: 
Note: you may want to use the Set Date button to select the time from the calendar to ensure you don’t  
          make a typo. Also, you can hold down the arrows on the spinboxes to rapidly index to a number. 

a. Start Date: 2013-06-01 00:00  
b. End Date: 2013-06-01 04:00 

 
 

11. Click the Finish button to create the case metadata. 
a. When WES is done creating metadata for the case, you will see Exercise Case listed in the Case Name 

list of Available Cases, and it will have a status of Not loaded. 
b. If you do not see your case listed, check under Window à Preferences and make sure /data1/wes_cases 

and /data2 have been added to your “Case directory paths” 
 

 
 

12. In the shell window with w2b_exercise_case_14_3_1 issue the following commands to list out the contents of the 
case after the metadata is added: 

a. ls w2b_exercise_case_14_3_1 
i. Note that the caseMetaData.xml and the localizations folder should now exist 

b. ls w2b_exercise_case_14_3_1/localizations 
i. Note that the localization utility tree and maps have been copied into the case from the AWIPS-2 

installed on WES-2 Bridge. 
 
 



 
13. Select the Exercise Case, right click on the row, and select Load Case. 

                   a.   In the Load Case tab, review the metadata, and then click Load to load the records into  
                         the database. 

i. This will take a minute or two, and the Progress Information bar will disappear when the data is 
loaded into an available EDEX instance.  

ii. If there are no available EDEX instances, you will be prompted to unload an EDEX instance 
before being able to proceed.  

iii. If  no EDEX instances are running, WES II Bridge should prompt you to start one. You can also 
manually start one by right-clicking on an instance in the instance manager and choosing “Start 
EDEX”. 
 

14. Drag the vertical bar to the right, so you can see the Status of Exercise Case is Loaded and under EDEX 
Instances which EDEX instance the case is loaded on. 
 

 
a. When a case is Loaded, it can be quickly accessed for event review or simulation. 

 
15. Right click on Exercise Case, and select Review. 

 
16. In the Review Wizard, click Finish. 

a. Click OK if the Low Available Memory for Application window appears. 
b. CAVE will load with all the data visible, and after 1 minute will set the D2D clock to the end of the case 

for reference. 
i. Note: The D2D clock is not frozen and moves forward past the end of the case, but has no 

impact. 
 

17. Under the ktlx menu select All tilts base data, increase frame count to 64, and navigate through the data. 
a. Note this is static case review (no simulation), so the data doesn't update automatically. 

 
18. Swap panes with an empty pane, and under the Obs menu select Local CWA Warnings and navigate through 

the data. 
 

19. Swap panes with an empty pane, and under the Satellite menu select 4 panel (GOES M-Q) and navigate 
through the data. 

 
20. Under the Upper Air menu, select Oklahoma City, OK and notice no data will load because this data type 

(bufrua) was not included in the archive case. 
 

 
 



21. Click on the D2D clock and enter 2013-6-1 for the date and 1-30-00 for the time and select Freeze time at this 
position. 

 
 

a. Your CAVE clock should have yellow text with a black background when the time is frozen: 
 

 
 

22. To launch another CAVE on this case, identify the EDEX Instance in the Case Name list of available cases (i.e. 
EDEX_02), and then in the EDEX Instances on the bottom left of the WES II Bridge, right click on the 
appropriate EDEX Instance row and select Start CAVE.   
 

 
 

a. Click OK on the available memory popup window if it pops up, and when CAVE launches, move the 
new CAVE to a new monitor. 
 
Note: You have to manually set the CAVE clock when using Start CAVE. 
 

23. Load and view data on the new CAVE and verify it is the same data. 
 

24. Shut down CAVE and the Text Workstation. 
 

 a. Any active EDEX started above can remain running even after shutting down CAVE. 
 

25. As a final step, reset the task for future users: 
 a.  In WES-2 Bridge under the list of Available Cases, right click on the Exercise Case and select “Unload    
      Case”. This step will unload the case from the EDEX it was loaded onto.  
 
 b. Navigate to /data1/wes_cases/w2b_exercise_case_14_3_1 and remove the localizations directory and the    
     caseMetaData.xml file.  

 



Task 2:  Run a Simulation on a Case Not Loaded: w2b_test_case_14_3_1  
 
1. Select  w2b_test_case_14_3_1 in the Case Name tab, and right click and select Simulation. 

 
2. In the Simulation tab (may need to move the vertical slider bar to see) enter the following: 

a. Simulation Data Time Range  
i. Start Date: 2013-05-31 22:25 

ii. End Date: 2013-06-01 00:00  
iii. Note: This task loads the whole case (no need to modify the Load Data Time Range). The 

Simulation Data Time Range will load a subset of the case for simulation.  
b. Under the WESSL Script, select TestScript.  

 

 
 

3. In the upper-right part of the simulation tab (may need to use scroll bars), click on the Simulate button. 
a. The case will first be Loaded into an available EDEX which will take a minute or two. 
b. If no EDEX instance is available you will need to unload a case by right clicking on a case name and 

selecting Unload. 
 

4. Click OK on the available memory popup window if it pops up, and note when the WESSL2 window and 
Simulation Controls window pops up. 

a.    Ignore any error messages about “Requested map level(s)”. 
 

5. Click the PLAY button on the Simulation Controls window. 
       a.    Note: You will be issuing a warning during this task. There may be an issue where warnings will not    
              display in D2D when running a simulation on a particular EDEX for the first time. To get around this, hit   
              STOP under Simulation controls, close CAVE and the WESSL window, and repeat steps 1- 4. You   
              will be able to view your warning in D2D on this EDEX in any future simulations.  

 



6. WESSL2 will pop up a new report every few minutes, and you can click on each one of the WESSL Events 
manually if you want to review them. 

a. During the simulation you will receive text, image, and video popups relaying information from various 
sources on this day. 
 

7. From the ktlx menu, select 0.5 Z+SRM8 and review the recent radar data.  
 

8. Under the CAVE menu and New submenu select Text Workstation, and then issue a tornado  
      warning with WarnGen (don’t spend much time doing it, just for demonstration  
      purposes), making sure to select a basis for the warning (radar detected, spotter, etc.)  
      and/or hail threat. 
         a.     If you receive a message about product expiration, click the “Go Ahead” button.  
               b.     If warning product does not display in the Text Workstation after you select “Create Text” in   
                       Warngen, navigate to CAVE à  Preferences à  Text Workstation and make sure the host matches  
                       the workstation name you are running WES II Bridge from.  

 
9. In a new pane, load the Local CWA Warnings plot from the Obs menu, and see your new  
      warning. 
 
10. The simulation will stop at 00:00:00. 

a. After the simulation has stopped, shut down CAVE and WESSL. 
 
Task 3: Build a WESSL Script and Play it in a Simulation 

 
1. Check to see if EDEX_00 is Active under the “EDEX Instances” tab. If it is listed as Not Active, right-click  
       and select Start EDEX. EDEX_00 MUST be active for Script Builder to run. 
 

 
 
2. Right-click on w2b_test_case_14_3_1 and select Launch Script Builder. 
 
3. Click on the folder icon, click the New button, and enter a name for your script. 

 

 
 



4. Double click on the Date and Time empty cell where you will enter in 2013-5-31-22-25 and click OK. 
 

 
 

a. Right-click in the Command box, and select Text. 
b. Click in the box and type “Begin Simulation”, and click OK. 

 
 

 
 
 



c. Click on the Play button to preview the event text popup. 
 

 
 

5. Click on the + sign to add an event, and double click on the Date and Time empty cell  where you will enter in 
2013-5-31-22-25 with the 15 Second checkbox selected and click OK. 

a. Right-click in the Command box, and select Image. 
b. Click on the Browse button and navigate to /data1/wes_cases/  
      w2b_test_case_14_3_1/wessl2/resources. 
c. Select 20130601_00_summary.png, and click the Open button. 
d. Click on the Backward then Forward Play buttons in the Event Previewer window already open, and 

the image will display. 
 

6. Click on the + sign to add an event, and double click on the Date and Time empty cell  where  
            you will enter in 2013-5-31-22-28 with the 15 Second checkbox selected and click OK. 

a. Right-click in the Command box, and select Video. 
b. Click on the Browse button and navigate to /data1/wes_cases/  
     w2b_test_case_14_3_1/wessl2/resources. 
c. Select Sequence_01.mov, and click the Open button. 
d. Click on the Backward then Forward Play buttons in the Event Previewer window  
      already open, and the video will play. 
 

7. Click on the + sign to add an event, and double click on the Date and Time empty cell  where you will enter in 
2013-5-31-22-35 with 30 Second selected and click OK. 

a. Right-click in the Command box, and select Map/Observation Event. 
b. Type in 35.47 for Latitude and -98.35 for Longitude and “Golf ball hail in Hinton, OK”, in the Report 

Text. Under Report type, select “HAIL” from the drop-down menu then click OK. 
c. Click on the Backward then Forward Play buttons in the Event Previewer to preview the event text 

popup. 
 
 
 
 
 
 
 
 
 



8. Click on the + sign to add an event, and double click on the Date and Time empty cell where you will enter in 
2013-5-31-22-40 with the 45 Second selected and click OK. 

a. Right-click on the box with a green checkmark, and select Pause (will pause the simulation with this 
event). 

b. Right-click in the Command box, and select Presentation. 
i. Presentation launches the Firefox browser on the file you specify. This is useful for 

incorporating content such as Flash modules, web page, or Articulate/Camtasia content. 
c. Left-click on the Browse button, and navigate to /data1/wes_cases/   
     w2b_test_case_14_3_1/wessl2/resources, select  
     Warning_LSR_Loop.html, and click Open and OK. 
d. Click on the Backward then Forward Play buttons in the Event Previewer to preview the debrief. 

 
9. Click on the + sign to add an event, and double click on the Date and Time empty cell  where you will enter in 

2013-5-31-22-40 with the 45 Second selected (same time as in previous step) and click OK. 
a. Right-click in the Command box, and select Text.  
b. Enter in some text saying the simulation has been paused and to click on the PLAY button to resume and 

click OK. 
c. Click on the Backward then Forward Play buttons in the Event Previewer to preview the event text 

popup. 
 

10. Click on the + sign to add an event, and double click on the Date and Time empty cell  where   
        you will enter in 2013-5-31-22-41 with the 00 Second selected and click OK. 

a. Right-click in the Command box, and select Presentation. 
b. Left-click on the Browse button, and navigate to /data1/wes_cases/   
 w2b_test_case_14_3_1/wessl2/resources, select engage.html, click Open and OK. 
c. Click on the Backward then Forward Play buttons in the Event Previewer to  
       preview the debrief module. 
 

11. After completing steps 3–9, your Script Builder window should be populated with events similar to this: 
 

 
 

12. Close the WES II Script Builder and Event Previewer windows and click Yes. 
 

13. Select w2b_test_case_14_3_1 in the Case Name tab, right click, and select Simulation since you now have the  
              case Loaded. 

 
 

 



14. In the Simulation tab Simulation Data Time Range enter 2013-05-31 22:25 for the Start Date and 2013-05-31 
00:00 for the End Date.  
 

 
 

15. Under the WESSL Script, select the script name you created in Step 3, and click the Finish button. 
 

16. Click OK on the available memory popup window, and note when the WESSL2 window and Simulation Controls 
window pops up. 

 
17. Click the PLAY button on the Simulation Controls window. 

 
18. WESSL2 will pop up your events as you created them. 




